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Diversity and Inclusion

Oracle is fully committed to diversity and inclusion. Oracle respects and values having a
diverse workforce that increases thought leadership and innovation. As part of our initiative to
build a more inclusive culture that positively impacts our employees, customers, and
partners, we are working to remove insensitive terms from our products and documentation.
We are also mindful of the necessity to maintain compatibility with our customers' existing
technologies and the need to ensure continuity of service as Oracle's offerings and industry
standards evolve. Because of these technical constraints, our effort to remove insensitive
terms is ongoing and will take time and external cooperation.

vii



Preface

Oracle Application Express End User’s Guide offers an introduction to using Oracle
Application Express applications from an end user's perspective. This guide explains
how to use interactive grids and interactive reports.

• Audience

• Documentation Accessibility

• Related Documents

• Conventions

Audience
Oracle Application Express End User's Guide is intended for end users who are
running Oracle Application Express applications. To use this guide, you must have a
general understanding of relational database concepts and an understanding of the
operating system environment under which you are running Oracle Application
Express.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Related Documents
For more information, see these Oracle resources:

• Oracle Application Express Release Notes

• Oracle Application Express Installation Guide

• Oracle Application Express App Builder User’s Guide

• Oracle Application Express Administration Guide

• Oracle Application Express SQL Workshop Guide

• Oracle Application Express API Reference

Preface
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• Oracle Application Express Accessibility Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.

Preface
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1
Changes in Release 21.2 for Oracle
Application Express End User’s Guide

All content in Oracle Application Express End User’s Guide has been updated to reflect
release 21.2 functionality and user interface changes.

New Features

New features include:

• Strip Rich Text switch

Interactive grids and interactive reports containing a Rich Text column can be
downloaded or emailed without Rich Text formatting (for CSV and XLSX file types) by
enabling the Strip Rich Text switch.

See Downloading or Emailing an Interactive Grid and Downloading a Report.

Deprecated and Desupported Features

See Deprecated Features and Desupported Features Oracle Application Express Release
Notes.
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2
About Oracle Application Express

Oracle Application Express is a rapid web application development tool for the Oracle
Database.

• Browser Requirements
Oracle Application Express requires a JavaScript-enabled browser and supports the
current and prior major release of Google Chrome, Mozilla Firefox, Apple Safari, and
Microsoft Edge.

• About Oracle Application Express
Oracle Application Express is a rapid web application development platform for the
Oracle Database.

• About Database Applications
A database application is an interactive user interface (UI) that enables you to display,
add, update, or delete information stored in a local Oracle Database or an external data
source using REST-based APIs. A database application can display information in many
formats, including static and interactive reports, forms, charts, and interactive grids.

See Also:

"Quick Start" in Oracle Application Express App Builder User’s Guide

2.1 Browser Requirements
Oracle Application Express requires a JavaScript-enabled browser and supports the current
and prior major release of Google Chrome, Mozilla Firefox, Apple Safari, and Microsoft Edge.

2.2 About Oracle Application Express
Oracle Application Express is a rapid web application development platform for the Oracle
Database.

Developers assemble an HTML interface (or application) on top of database objects with
wizards or direct input. Each application is a collection of linked pages using tabs, buttons, or
hypertext links.

You can manage, manipulate, and display the data in a local Oracle Database or an external
data source using REST-based APIs.

2.3 About Database Applications
A database application is an interactive user interface (UI) that enables you to display, add,
update, or delete information stored in a local Oracle Database or an external data source
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using REST-based APIs. A database application can display information in many
formats, including static and interactive reports, forms, charts, and interactive grids.

This guide explains how you can customize interactive grids and interactive reports. In
an interactive grid or interactive report, you can customize the appearance of report
data through searching, filtering, sorting, column selection, highlighting, and other data
manipulations. You can save your customizations in the application or, depending on
the developer’s configuration, you can also download reports locally for offline use.

Chapter 2
About Database Applications
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3
Using Interactive Grids

An interactive grid presents a set of data in a searchable, customizable report. In an editable
interactive grid, users can also add to, modify, and delete the data set directly on the page.

• About Interactive Grids
Interactive grids feature many ways to change how the data is displayed. Options include
the Actions menu, Column Heading menus, and the ability to rearrange the report
interactively using the mouse.

• About Editable Interactive Grids
Editable interactive grids possess all the same functionality of regular interactive grids,
plus some additional functions in the interface and the customization menus. You can
add, edit, delete, and refresh much of the underlying data in an editable grid.

• Using an Interactive Grid
Use the interactive grid’s menus and interface to search the grid, add elements such as
filters and computations, reorganize with sort and breaks, and further customize how the
data displays.

• Customizing an Interactive Grid with the Actions Menu
Reconfigure and augment how an interactive grid displays data by using the Actions
menu.

• Customizing an Interactive Grid with the Column Heading Menu
Use the Column Heading menu to quickly customize a column in an interactive grid.

• Using an Editable Interactive Grid
Editable interactive grids expand the functionality of regular interactive grids to enable
you to more directly update a grid’s structure and contents. You can add and delete rows,
edit cell contents, and refresh the grid with the latest updates.

• Saving Interactive Grids
Save your changes as a new report within the application. Name and keep these
interactive grid reports Private or make them Public to share with other users.

• Resetting Interactive Grids
You can refresh, reset, or flashback a grid to revert your changes to it. Resetting an
interactive grid can have different outcomes depending on the report type.

• Downloading or Emailing an Interactive Grid
Download or email an interactive grid as a CSV, HTML, Excel, or PDF file by selecting
Download in the Actions menu.

See Also:

"Managing Interactive Grids" in Oracle Application Express App Builder User’s
Guide
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3.1 About Interactive Grids
Interactive grids feature many ways to change how the data is displayed. Options
include the Actions menu, Column Heading menus, and the ability to rearrange the
report interactively using the mouse.

Interactive Grid Interface

By default, all interactive grids have a search bar, Actions menu, and Reset button.
Interactive grids also have Column Heading Menus, which you access by clicking the
name or heading of a column.

You can hide, filter, freeze, highlight, sort, and create control breaks on individual
columns with the Actions and Column Heading menus. Advanced users can also
define aggregations, which appear at the bottom of the column or column group.

Chapter 3
About Interactive Grids
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Using the mouse, you can resize columns or drag and drop columns into different places to
directly customize the appearance of an interactive grid. (The width and order of columns can
also be configured in the Columns dialog.)

You can quickly chart the data with the Chart function. This feature is useful for quick data
visualization or even presentation, and responds immediately to changes in the data.

You can quickly revert your modifications with the Reset function or perform an incremental
revert with the Flashback function. You can use the Refresh function to pull in the latest
version of the data on the database (useful for highly dynamic datasets).

Reports in Interactive Grids

You can save your customizations to an interactive grid by creating a custom report by
selecting Report, Save As from the Actions menu.

See Also:

• About Interactive Grid Report Types

3.2 About Editable Interactive Grids
Editable interactive grids possess all the same functionality of regular interactive grids, plus
some additional functions in the interface and the customization menus. You can add, edit,
delete, and refresh much of the underlying data in an editable grid.

Chapter 3
About Editable Interactive Grids
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About Editable Interactive Grids

Editable interactive grids enable users to change or update data. An editable
interactive grid allows you to select, add, and change a grid’s contents in real time,
similar to working in spreadsheet software.

Editable Cells

You can change the contents of an individual cell in real time by double-clicking a cell.

You can also toggle the Edit button to enable improved keyboard usability when
updating multiple columns. For example, rather than pointing and clicking on every cell
in the grid, you can use the Tab and Ctrl + Tab keys to move focus across cells in a
row.

Editable Rows

The primary way of adding new content to an editable interactive grid is by adding new
rows. You can use the Row Actions menu to edit an individual row, or the Selection
Actions menu to edit multiple rows at once.

3.3 Using an Interactive Grid
Use the interactive grid’s menus and interface to search the grid, add elements such
as filters and computations, reorganize with sort and breaks, and further customize
how the data displays.

• Searching in an Interactive Grid
Search an interactive grid by entering criteria into the Search Bar.

• Rearranging Columns Using Drag and Drop
Drag and drop a column into place by clicking and holding the drag handle on the
column heading.

• Resizing Columns in an Interactive Grid
Resize the width of a column by clicking and holding the edge of a column heading
and adjusting it with the mouse.

• Sorting Columns in an Interactive Grid
Specify the alphabetical, numerical, or chronological order of a column by clicking
the Sort Ascending and Sort Descending buttons on the column heading.

• Using Charts in an Interactive Grid
Create a chart in an interactive grid by selecting Chart in the Actions menu. Edit or
remove the chart with the Edit Chart link.

3.3.1 Searching in an Interactive Grid
Search an interactive grid by entering criteria into the Search Bar.

Tip:

You can also search an interactive grid using a supported browser’s search
function (such as Ctrl + F or Cmd + F).

Chapter 3
Using an Interactive Grid
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• About the Search Bar
You can perform text searches with the Search Bar at the top of an interactive grid.

• Using the Select Columns To Search Icon
Narrow your search parameters by clicking the Select Columns to Search icon
(magnifying glass).

3.3.1.1 About the Search Bar
You can perform text searches with the Search Bar at the top of an interactive grid.

Select Columns to Search icon
Resembles a magnifying glass. Narrows your search.
See "Using the Select Columns To Search Icon."

Text area
Displays entered search criteria (wildcard characters are implied).

Go button
Executes a search.

3.3.1.2 Using the Select Columns To Search Icon
Narrow your search parameters by clicking the Select Columns to Search icon (magnifying
glass).

To search a specific column:

1. Click the Select Columns to Search icon.

2. Select the name of a column.

3. (Optional) To enable case sensitive searching, select Case Sensitive.

Note:

Search only works in columns with alphabetical characters. Search does not
work in number or date columns.

4. Enter a search string in the Search field.

5. Press the Enter key or click Go.

The interactive grid reloads with a filter applied.
To reset the search bar back to the default setting, click the Select Columns to Search icon
and select All Text Columns.

You may need to disable or remove existing filters for broader searching to take effect.

Chapter 3
Using an Interactive Grid
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See Also:

• Disabling a Filter in an Interactive Grid

• Removing a Filter from an Interactive Grid

3.3.2 Rearranging Columns Using Drag and Drop
Drag and drop a column into place by clicking and holding the drag handle on the
column heading.

You can also rearrange the order of the columns in the Columns dialog.

To drag and drop a column:

1. Hover the mouse over a column heading to display the drag handle.

 

 
The mouse cursor also changes when it comes into contact with the drag handle.

2. Click and hold the drag handle.

3. Drag the column to the desired location.

The heading shifts out of place in the row.

4. While holding the mouse, use the indicator to determine which column to place the
dragged column ahead of.

5. Release the mouse.

The column drops into place.

To undo all changes, click the Reset button.

WARNING:

Resetting an interactive grid reverts it to a previously saved state. Any
changes since that time may be lost.

Chapter 3
Using an Interactive Grid
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See Also:

• Changing the Column Display in an Interactive Grid

• Keyboard Shortcuts in Interactive Grid Regions in the Oracle Application
Express Accessibility Guide

3.3.3 Resizing Columns in an Interactive Grid
Resize the width of a column by clicking and holding the edge of a column heading and
adjusting it with the mouse.

To resize a column with your mouse:

1. Hover your mouse cursor over the edge of column heading until the cursor changes.

 

 

2. Click and hold the mouse.

3. Move the mouse left and right to achieve the desired width.

4. Release the mouse.

The column resizes.
To undo all changes, click the Reset button.

WARNING:

Resetting an interactive grid reverts it to a previously saved state. Any changes
since that time may be lost.

See Also:

• Changing the Column Display in an Interactive Grid

• Keyboard Shortcuts in Interactive Grid Regions in the Oracle Application
Express Accessibility Guide

Chapter 3
Using an Interactive Grid
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3.3.4 Sorting Columns in an Interactive Grid
Specify the alphabetical, numerical, or chronological order of a column by clicking the
Sort Ascending and Sort Descending buttons on the column heading.

To specify the sort order of a column:

1. Hover the mouse in the column heading.

The Sort Ascending and Sort Descending buttons display.

2. Do one of the following:

• To sort a column in ascending order (A to Z, 1 to 9, earliest to latest), click the
Sort Ascending button (up arrow).

• To sort a column in descending order (Z to A, 9 to 1, latest to earliest), click the
Sort Descending button (down arrow).

• To remove an existing sort, click the toggled button again (now labeled Don’t
Sort).

The column sorts.

Chapter 3
Using an Interactive Grid
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3.3.5 Using Charts in an Interactive Grid
Create a chart in an interactive grid by selecting Chart in the Actions menu. Edit or remove
the chart with the Edit Chart link.

To create a chart from the data in an interactive grid:

1. Click the Actions menu and select Chart.

The Chart dialog appears.

2. Select a chart type.

The dialog populates with options specific to the selected chart type. For example, a bar
chart has a different set of configuration fields than a pie chart. Select different types to
see the range of available options.
 

 

3. Configure the chart settings.

For example, the following is a configuration for a Bar chart:

• Orientation - Select Vertical for the bars to increase toward the top of the chart, or
Horizontal to increase toward the right.

• Label - Select the column to be used as the Label (the label appears beneath or
beside the bar).

• Value - Select the column to be used as the Value (the value is the quantity that
determines the size of the bar).

• Aggregation - (Optional) Select an additional aggregation to be performed on the
column selected for the Value. Valid selections include: Count, Count Distinct,
Minimum, Maximum, Sum, or Average.

4. Click Save.

Chapter 3
Using an Interactive Grid
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The chart appears. The following is an example of a bar chart that depicts project
budgets with a sum aggregation. To switch the view between Grid and Chart, click the
toggle that now appears at the top of the interactive grid.
 

 
To reconfigure the chart, click the Edit Chart link.

To remove a chart, click the Remove Chart icon (X) adjacent to the chart link.

You can only create one chart at a time in an interactive grid. To create a second chart,
reconfigure the existing chart by clicking Edit Chart, or delete it by clicking the
adjacent Remove Chart icon (X).

See Also:

Filtering an Interactive Grid

3.4 Customizing an Interactive Grid with the Actions Menu
Reconfigure and augment how an interactive grid displays data by using the Actions
menu.

Chapter 3
Customizing an Interactive Grid with the Actions Menu
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• Changing the Column Display in an Interactive Grid
Edit which columns display and in what order by selecting Columns in the Actions menu.

• Filtering an Interactive Grid
Filter an interactive grid by column, row, or both, with text strings and using operators
such as contains and equals.

• Selecting Column Sort Order in an Interactive Grid
Specify the sort order (ascending or descending) of a column by selecting Sort on the
Data submenu. You can also specify how to handle NULL values.

• Defining an Aggregation in an Interactive Grid
Define an aggregation in an interactive grid by selecting Aggregate from the Actions,
Format submenu. Aggregates display after each control break and at the end of the
interactive grid within the column for which they are defined.

• Creating a Control Break from the Actions Menu in an Interactive Grid
Break an interactive grid (that is, compartmentalize the layout) by column by selecting
Control Break in the Actions, Format submenu.

• Adding Highlighting to an Interactive Grid
Apply color effects to an interactive grid by selecting Highlight in the Actions, Format
submenu.

3.4.1 Changing the Column Display in an Interactive Grid
Edit which columns display and in what order by selecting Columns in the Actions menu.

To edit how columns display in an interactive grid:

Chapter 3
Customizing an Interactive Grid with the Actions Menu
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1. Click the Actions menu and select Columns.

The Columns dialog displays.

2. Edit the columns:

• Displayed - Select the check box to show a column in the grid; deselect a
check box to hide a column in the grid.

• Move Up and Move Down - Adjust the order in which a column appears in the
grid.

• Columns button - Toggle whether the list displays All, Displayed, or Not
Displayed (hidden) columns.

• Minimum Column Width (Pixel) - Adjust the displayed numeric value to
widen or narrow the column (for example, a higher number widens the
column).

3. Click Save.

The interactive grid refreshes.

3.4.2 Filtering an Interactive Grid
Filter an interactive grid by column, row, or both, with text strings and using operators
such as contains and equals.

• About Filters in Interactive Grids
You can narrow the contents of an interactive grid by applying a filter to it. Once
applied, filters can be temporarily enabled or disabled or removed permanently
directly in the interactive grid. You can also click the filter name for quick
reconfiguration.

• Creating a Row Filter in an Interactive Grid
Create a row filter to limit the number of rows returned in an interactive grid.
Filtering by row filters for a term in any filterable column.

• Creating a Column Filter in an Interactive Grid
Filter a column in an interactive grid with a specified operator and value.

• Editing a Filter in an Interactive Grid
Edit a filter by clicking the name of a filter to open the Filters dialog. The Filters
dialog enables you to edit properties of any filter.

• Disabling a Filter in an Interactive Grid
Disable a filter by clicking the check box adjacent to the name of the filter.

• Removing a Filter from an Interactive Grid
Remove a filter by deleting it in the Filters dialog or by clicking the adjacent
Remove Filter icon (X).

3.4.2.1 About Filters in Interactive Grids
You can narrow the contents of an interactive grid by applying a filter to it. Once
applied, filters can be temporarily enabled or disabled or removed permanently directly
in the interactive grid. You can also click the filter name for quick reconfiguration.
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Existing filters display between the search bar and the grid.

Rather than deleting a filter, you can disable it by deselecting the adjacent checkbox. You can
leave a filter disabled and save your report to preserve it for future usage.

To edit a filter, you can click its name or open the Filters dialog and select it in the list.

You can permanently remove a filter by clicking the adjacent Remove Filter icon (X) or by
removing it from the list in the Filters dialog.

3.4.2.2 Creating a Row Filter in an Interactive Grid
Create a row filter to limit the number of rows returned in an interactive grid. Filtering by row
filters for a term in any filterable column.

To add a filter to the rows in an interactive grid:

1. Click the Actions menu.

2. Select Filter.

The Filters dialog displays.

3. In the Filters dialog:

a. Type - Select Row.

b. Search - Enter the text string to filter.

c. Case Sensitive - Enable to make the filter case sensitive.

4. Click Save.

The interactive grid applies the filter.

3.4.2.3 Creating a Column Filter in an Interactive Grid
Filter a column in an interactive grid with a specified operator and value.
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To add a filter to a column in an interactive grid:

1. Click the Actions menu.

2. Select Filter.

The Filters dialog displays.

3. In the Filters dialog:

a. Type - Select Column.

b. Column - Choose the column to filter.

c. Operator - Choose the filter logic.

d. Value - Enter the filter criterion.

4. Click Save.

The filter is added to the grid.

3.4.2.4 Editing a Filter in an Interactive Grid
Edit a filter by clicking the name of a filter to open the Filters dialog. The Filters dialog
enables you to edit properties of any filter.

To edit an existing filter:

1. Click the name of a filter.

The Filters dialog displays.

2. Edit the filter by selecting new values.

Editable parameters include:

• the filter type (row, column)

• the name of the row or column the filter applies to

• the filter operator

• the filtered value

Other filters can also be added, edited, enabled, and removed in this dialog.

3. To add a new filter:

a. Click the Add button (+) adjacent to the Filters list.
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b. Configure the appropriate fields.

4. Click Save to apply your changes.

3.4.2.5 Disabling a Filter in an Interactive Grid
Disable a filter by clicking the check box adjacent to the name of the filter.

Disabling a filter is often preferable to deleting it because disabling saves the time of
recreating and reconfiguring the same filter.

• To disable a filter in an interactive grid:

• Click the check box adjacent to the name of the filter.

The interactive grid reloads and the check box unchecks.
To re-enable the filter, click the check box again.

3.4.2.6 Removing a Filter from an Interactive Grid
Remove a filter by deleting it in the Filters dialog or by clicking the adjacent Remove Filter
icon (X).

Tip:

To temporarily disable a filter, deselect the adjacent check box either within the
Filters dialog or above the interactive grid.

To remove a filter, do one of the following:

• Open the Filters dialog and delete it:

1. Click the Actions menu and select Filter.

The Filters dialog appears.

2. In the list of filters, select the filter to remove.

3. Click the Delete button (-).
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4. Click Save.

• Above the interactive grid, click the Remove Filter icon (X) adjacent to a filter.

 

 

3.4.3 Selecting Column Sort Order in an Interactive Grid
Specify the sort order (ascending or descending) of a column by selecting Sort on the
Data submenu. You can also specify how to handle NULL values.

To sort by column:

1. Click the Actions menu, select Data, then Sort.

The Sort dialog appears.

2. In the Sort dialog: Select a column, the sort direction (Ascending or
Descending), and the null sorting behavior (Default, Nulls Always Last, or Nulls
Always First).

a. Column - Select a column.

b. Direction - Select Descending or Ascending.

c. Nulls - Select First or Last.

3. To add another sort rule, click the Add button (+).

4. Click Save.

The interactive grid reloads.
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3.4.4 Defining an Aggregation in an Interactive Grid
Define an aggregation in an interactive grid by selecting Aggregate from the Actions, Format
submenu. Aggregates display after each control break and at the end of the interactive grid
within the column for which they are defined.

• Creating an Aggregation in an Interactive Grid
Create an aggregation in an interactive grid by selecting Aggregate in the Actions, Data
submenu.

• Editing an Aggregation in an Interactive Grid
Edit an existing aggregations by selecting the Aggregate in the Actions, Data submenu.

• Removing an Aggregation in an Interactive Grid
Use the Aggregate dialog to remove an aggregation.

3.4.4.1 Creating an Aggregation in an Interactive Grid
Create an aggregation in an interactive grid by selecting Aggregate in the Actions, Data
submenu.

To create an aggregation against a column:

1. Click the Actions menu, select Data, then Aggregate.

The Aggregation dialog appears. (Some fields may be pre-filled.)

 

 

2. In the Aggregation dialog:

a. Column – Select the column to define against

b. Aggregation – Select the type of aggregation to apply
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c. Tooltip – (Optional) Add a label that appears when you hover the mouse over
the aggregation.

d. (Optional) Show Overall Value – Select to display the grand total of a column

3. To add another aggregation:

a. Click the Add icon (+).

A new Aggregation appears in the list.

b. Define the new aggregation as described in the previous step.

4. Click Save.

The result of the aggregation appears at the bottom of the last page of the report.

The following example is an interactive grid with two sum aggregations applied to two
different columns (a control break has also been applied to simplify the presentation):

 

 

3.4.4.2 Editing an Aggregation in an Interactive Grid
Edit an existing aggregations by selecting the Aggregate in the Actions, Data
submenu.

To edit an aggregation with the Aggregate dialog:

1. Click the Actions menu.

2. Select the Data submenu, then Aggregate.

The Aggregate dialog displays.
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3. Select an aggregation.

4. Edit the aggregation. Editable fields include the column to define against, the function
type, Tooltip, and Show Overall Value.

5. Click Save.

3.4.4.3 Removing an Aggregation in an Interactive Grid
Use the Aggregate dialog to remove an aggregation.

Tip:

You can delete or disable an aggregation by interacting with the aggregation filter
above the interactive grid. To delete an aggregation, click the Remove
Aggregation icon (X); to disable an aggregation, select the adjacent check box.

To remove an aggregation with the Aggregation dialog:

1. Click the Actions menu.

2. Select the Data submenu, then Aggregate.

The Aggregation dialog displays.

3. Do one of the following:

• To hide an aggregation from view in the grid, click the adjacent checkbox in the
Enabled column. This disables the aggregation and stores it for future use in the
Aggregation dialog.
 

 

• To remove the selected aggregation from the grid completely and permanently, click
the Delete icon (—).
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4. Click Save.

3.4.5 Creating a Control Break from the Actions Menu in an Interactive
Grid

Break an interactive grid (that is, compartmentalize the layout) by column by selecting
Control Break in the Actions, Format submenu.

Creating a break group pulls the columns out of the interactive grid and displays them
as a master record.

To create a control break:

1. Click the Actions menu and select Format then Control Break.

The Control Break dialog displays.

2. In the Control Break dialog:

a. Column - Select the name of the column.

b. Direction - Select the sort direction (Ascending or Descending).

c. Nulls - Select the null sorting behavior (First or Last).

3. Click Save.

The interactive grid reloads with the control break applied for the selected column, and
a control break filter appears above the grid near the toolbar.

In the following example, a control break has been applied to the interactive grid for
the Project column.
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To edit a control break, click the name to display the Control Break dialog. You can also add,
edit, and delete other control breaks in the Control Break dialog.

To remove a control break, click the Remove Control Break icon (X) on the control break
filter.

See Also:

About Filters in Interactive Grids

3.4.6 Adding Highlighting to an Interactive Grid
Apply color effects to an interactive grid by selecting Highlight in the Actions, Format
submenu.

To highlight an interactive grid cell:

1. Click Actions and select Format then Highlight.

The Highlight dialog displays.

2. In the Highlight dialog:

Chapter 3
Customizing an Interactive Grid with the Actions Menu

3-21



a. Name - Enter the name of the highlight (this name displays as a filter above
the interactive grid).

b. Highlight - Choose the Row or Column to apply the highlight.

c. Background Color - Select the color of the background in a highlighted cell.
Choose a specific RGB value or a basic color from a list of presets.

d. Text Color - Select the color of the text in a highlighted cell. Choose a specific
RGB value or a basic color from a list of presets.

3. (Optional) In the Highlight dialog, configure advanced highlighting conditions. For
example, to conditionally highlight all tasks with a Status of Closed:

a. Condition Type - Select Column.

b. Column - Select Status.

c. Operator - Select equals.

d. Value - Click the arrow to display the drop-down list of valid values and select
Closed from the drop-down list.

4. To add an additional highlight, click the Add icon (+); click the Delete icon (—) to
remove an existing highlight.

5. Click Save.

3.5 Customizing an Interactive Grid with the Column
Heading Menu

Use the Column Heading menu to quickly customize a column in an interactive grid.

• About the Column Heading Menu in an Interactive Grid
The Column Heading Menu contains buttons to sort, break, aggregate, freeze, and
hide a column, as well as a text filter for searching within a column.

• Displaying the Column Heading Menu
Display a column’s Column Heading menu by clicking the heading of the column.

• Creating a Control Break in an Interactive Grid
Create a break group in an interactive grid by clicking the Control Break icon in the
Column Heading menu.

• Creating an Aggregation with the Column Heading Menu
Quickly apply an aggregation to an interactive grid by clicking the Aggregate icon
in the Column Heading menu.

• Freezing Columns in Place
Freeze a column in place by clicking the Freeze icon in the Column Heading
menu. Freezing a column excludes it from the scrollable area so that the frozen
column is always visible.

• Hiding Columns in an Interactive Grid
Hide a column in an interactive grid from view by clicking the Hide icon in the
Column Heading menu.

• Unhiding Columns in an Interactive Grid
Show a hidden column in an interactive grid by opening the Columns dialog and
enabling it in the Displayed column.
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• Filtering with the Column Heading Menu
Filter an interactive grid by the contents of a column by entering keywords in the Search
field of the Column Heading menu.

3.5.1 About the Column Heading Menu in an Interactive Grid
The Column Heading Menu contains buttons to sort, break, aggregate, freeze, and hide a
column, as well as a text filter for searching within a column.

Overview

The Column Heading menu contains Sort Order buttons, a Toolbar, a Text Filter, and a unique
list of the column’s contents.

Sort Order Buttons

The Sort Ascending and Sort Descending buttons appear at the right of every column
heading.

See "Sorting Columns in an Interactive Grid."

Button Toolbar

The toolbar on the Column Heading menu contains the following buttons and functions.

• Control Break - Creates a Control Break in the interactive grid based on the selected
column.

See "Creating a Control Break in an Interactive Grid."
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• Aggregate - Opens the Aggregation dialog to define an aggregation against the
selected column.

See "Creating an Aggregation in an Interactive Grid."

• Freeze - Freezes the selected column in place, preventing horizontal scrolling.

See "Freezing Columns in Place."

• Hide - Hides the selected column from view.

See "Hiding Columns in an Interactive Grid."

Text Filter

The text filter dynamically limits the list of column contents based on the text string
entered into the filter field.

See "Filtering with the Column Heading Menu."

3.5.2 Displaying the Column Heading Menu
Display a column’s Column Heading menu by clicking the heading of the column.

To display a column’s Column Heading menu:

• Click the heading of a column in an interactive grid.

The Column Heading menu displays.
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3.5.3 Creating a Control Break in an Interactive Grid
Create a break group in an interactive grid by clicking the Control Break icon in the Column
Heading menu.

 

 

Creating a break group pulls the columns out of the interactive grid and displays them as a
master record.

To create a control break:

1. Click the heading of the desired break group column.

The Column Heading menu appears.

2. Click the Control Break icon.

The interactive grid reloads with the control break applied for the selected column, and a
control break filter appears above the grid near the toolbar.

In the following example, a control break has been applied to the interactive grid for the
Project column.
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To remove a control break, click the Remove Control Break icon (X) on the control
break filter.

See Also:

• About Filters in Interactive Grids

• Creating a Control Break from the Actions Menu in an Interactive Grid
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3.5.4 Creating an Aggregation with the Column Heading Menu
Quickly apply an aggregation to an interactive grid by clicking the Aggregate icon in the
Column Heading menu.

To apply an aggregation against a selected column:

1. Click the heading of the column to display the Column Heading menu.

2. Click the Aggregate icon.

The Aggregation dialog appears.

3. Configure the aggregation.

4. Click Save.

The interactive grid reloads with the aggregation applied.

See Also:

"Creating an Aggregation in an Interactive Grid"

3.5.5 Freezing Columns in Place
Freeze a column in place by clicking the Freeze icon in the Column Heading menu. Freezing
a column excludes it from the scrollable area so that the frozen column is always visible.

To freeze a column in place:

Chapter 3
Customizing an Interactive Grid with the Column Heading Menu

3-27



1. Click the heading of the column that you wish to freeze.

The Column Heading menu appears.

2. Click the Freeze icon.

The scroll bar resizes to fit the new scrollable area.
To unfreeze a frozen column, reopen the Column Heading menu and click the
Unfreeze icon (snowflake).

3.5.6 Hiding Columns in an Interactive Grid
Hide a column in an interactive grid from view by clicking the Hide icon in the Column
Heading menu.

To hide a column in an interactive grid:

1. Click the heading of the column to display the Column Heading menu.

2. Click the Hide icon.

The column disappears. Remaining columns shift sideways to fill the space.

To redisplay hidden columns:

3. Click the Actions menu.

4. Select Columns.

The Columns dialog displays.

5. In the Displayed column, select the check box adjacent to the name of the hidden
column.

Tip:

Narrow the list of columns to only the hidden columns by clicking the
Columns icon and selecting Not Displayed.

6. Click Save.
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Tip:

You can also reset the grid to redisplay a hidden column. Resetting an interactive
grid reverts it to a previously saved state. Any changes since that time may be lost.
To reset the grid, click the Reset button.

3.5.7 Unhiding Columns in an Interactive Grid
Show a hidden column in an interactive grid by opening the Columns dialog and enabling it in
the Displayed column.

 

 

To show a hidden column in an interactive grid:

1. Click the Actions menu.

2. Select Columns.

The Columns dialog displays.

3. In the Displayed column, select the check box adjacent to the name of the hidden
column.

Tip:

Narrow the list of columns to only the hidden columns by clicking the Columns
icon and selecting Not Displayed.
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4. Click Save.

The column appears in the interactive grid.

3.5.8 Filtering with the Column Heading Menu
Filter an interactive grid by the contents of a column by entering keywords in the
Search field of the Column Heading menu.

To filter an interactive grid by column:

1. Click the heading of the column that you wish to sort by.

The Column Heading menu displays.

2. Do one of the following:

• Click within the Filter... text area.

• Press the Tab key until the cursor is within the Filter... text area.

3. Enter the text string you wish to filter by. Wildcards (such as quotation marks) are
valid.

4. Do one of the following:

• Press Enter to execute the filter.

• Select an entry from a list of valid strings that autogenerates when you start
typing.

The interactive grid redisplays with the filter applied.
To remove a filter, click the adjacent Remove Filter icon (X).
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See Also:

"Filtering an Interactive Grid"

3.6 Using an Editable Interactive Grid
Editable interactive grids expand the functionality of regular interactive grids to enable you to
more directly update a grid’s structure and contents. You can add and delete rows, edit cell
contents, and refresh the grid with the latest updates.

• Adding a Row in an Editable Interactive Grid
Click the Add Row button to add a new row to an editable interactive grid.

• Editing Rows in an Interactive Grid
Edit rows of an editable interactive grid with the Row Actions Menu, Edit button, and
other functions in the interface.

• Deleting a Row in an Interactive Grid
Use the Row Actions Menu to delete a row from an editable interactive grid.

• Modifying Multiple Rows and Cells in an Editable Interactive Grid
Quickly modify the values of multiple rows and cells with the Actions, Selection submenu.

3.6.1 Adding a Row in an Editable Interactive Grid
Click the Add Row button to add a new row to an editable interactive grid.

• To add a new row to the top of an editable interactive grid:

• Click the Add Row button.

A blank row appears at the top of the grid or below the currently selected row.

3.6.2 Editing Rows in an Interactive Grid
Edit rows of an editable interactive grid with the Row Actions Menu, Edit button, and other
functions in the interface.

• About the Row Actions Menu in an Editable Interactive Grid
The Row Actions Menu appears in editable interactive grids. Users can quickly edit the
rows of an editable grid with functions such as adding, duplicating, deleting, refreshing,
and reverting rows.

• About the Edit Button in an Editable Interactive Grid
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• Editing a Cell in an Interactive Grid
Double-click a cell in an editable interactive grid to edit the contents.

• Editing Multiple Rows in an Editable Interactive Grid
Select the desired rows of an editable interactive grid to edit, then select an option
from the Selection Actions menu.

3.6.2.1 About the Row Actions Menu in an Editable Interactive Grid
The Row Actions Menu appears in editable interactive grids. Users can quickly edit the
rows of an editable grid with functions such as adding, duplicating, deleting, refreshing,
and reverting rows.

Single Row View
Changes the grid display to a single-page view of a row’s contents. Used for viewing
an individual row in detail, one row at a time. Click the Previous and Next buttons to
navigate between rows in the grid. Click the Report View button to return to the grid.
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Add Row
Adds a new row below the current one.

Duplicate Row
Creates a copy of the currently selected row and inserts the copy below the original.

Delete Row
Deletes the row.

Refresh Row
Reloads the row by calling the database and pulling in any updates.
Refresh a row to update it without reloading the entire application page.

Revert Changes
Undoes any changes to the row since the grid was last saved.

See Also:

Editing Multiple Rows in an Editable Interactive Grid

3.6.2.2 About the Edit Button in an Editable Interactive Grid
The Edit button toggles Editing mode in editable interactive grids. When enabled, you can
single-click a cell to edit it; when disabled, you must double-click. While Editing mode enables
quicker editing of multiple cells in succession, it can impede navigation in larger grids.

3.6.2.3 Editing a Cell in an Interactive Grid
Double-click a cell in an editable interactive grid to edit the contents.
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To edit the contents of a single cell in an editable interactive grid:

1. Double-click a cell.

Editing mode engages and a cursor displays in the cell.

2. Edit the cell contents.

3. Press Tab or Shift + Tab to edit an adjacent cell in the row or Enter or Shift +
Enter to edit an adjacent cell in the column.

4. To exit editing mode, press Escape.

5. Click Save to save your changes.

Changes to the interactive grid are saved.

3.6.2.4 Editing Multiple Rows in an Editable Interactive Grid
Select the desired rows of an editable interactive grid to edit, then select an option
from the Selection Actions menu.

To edit multiple rows in an editable interactive grid:

1. Select rows by selecting check boxes in the check box column.

Tip:

Click the check box in the column heading to select all rows. With all
rows selected, click it again to deselect all rows.

2. In the column heading of the interactive grid, click the Selection Actions menu
icon

3. Select a valid option. Options include Copy to Clipboard, Duplicate Rows, Delete
Rows, Refresh Rows, Revert Changes, Copy Down, Fill, and Clear.

The selected change applies.

3.6.3 Deleting a Row in an Interactive Grid
Use the Row Actions Menu to delete a row from an editable interactive grid.

To delete a row from an editable grid:
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1. Click the Row Actions menu icon adjacent to the row.

2. Select Delete Row.

The row is crossed out in the grid.
 

 

3. To finalize the deletion, click Save.

The grid reloads with the selected row removed.

3.6.4 Modifying Multiple Rows and Cells in an Editable Interactive Grid
Quickly modify the values of multiple rows and cells with the Actions, Selection submenu.

• About Selection Modes in an Editable Interactive Grid
You can select rows or groups of cells in an interactive grid by toggling between selection
modes.

• Changing Selection Mode in an Editable Interactive Grid
Switch between Cell Selection mode and Row Selection mode by using the Actions,
Selection submenu.

• Copying to Multiple Rows in an Editable Interactive Grid
Copy the value of a row and apply it to a group of rows by using Copy Down in the
Actions, Selection submenu.

• Copying to Multiple Cells in an Editable Interactive Grid
Copy the value of a cell and apply it to a group of cells in the same column by using Copy
Down in the Actions, Selection submenu.

• Filling Cells in an Editable Interactive Grid
Apply a single value to a group of cells in an editable interactive grid by using Fill in the
Actions, Selection submenu.

• Clearing Cells in an Interactive Grid
Delete the contents of multiple cells by using Clear in the Actions, Selection submenu.

3.6.4.1 About Selection Modes in an Editable Interactive Grid
You can select rows or groups of cells in an interactive grid by toggling between selection
modes.

Row Selection
Row Selection is the default selection mode in interactive grids. Check boxes appear next to
every row in the left-hand column, so you can select multiple individual rows at once by
mouse-click. You can also press the arrow keys on the keyboard to navigate up and down
between rows, or hold the Shift key at the same time to select multiple adjacent rows.
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With multiple rows selected, you can use the Selection menus to apply a single
change to the entire selection.

Cell Selection
You can switch to Cell Selection mode in the Selection submenu in the Actions menu
or by pressing F8.
In Cell Selection mode, the check boxes disappear, and you can select individual cells
by mouse-click. You can also hold the Shift key and use mouse or the arrow keys to
select multiple adjacent cells.
With multiple cells selected, you can use the Selection menus to apply a single
change to the entire selection.

3.6.4.2 Changing Selection Mode in an Editable Interactive Grid
Switch between Cell Selection mode and Row Selection mode by using the Actions,
Selection submenu.

Interactive grids are in Row Selection mode by default. You can switch to selection
modes to select groups of rows or cells.

1. To switch selection modes, do one of the following:

• Click the Actions menu, select Selection, and click Cell Selection or Row
Selection.

• Press F8 on your keyboard (Tip: ensure only one or no objects are selected).

The selection mode switches.

2. To switch back, repeat this step.

3.6.4.3 Copying to Multiple Rows in an Editable Interactive Grid
Copy the value of a row and apply it to a group of rows by using Copy Down in the
Actions, Selection submenu.

To apply the value of an existing row to a group of rows below it:

1. Ensure you are in Row Selection mode.

2. Select the row you want to copy.

3. Do one of the following to select the rows you want to change:

• Using the mouse, click the adjacent check boxes. Using the check boxes
enables you to apply changes to non-contiguous rows.

• Using the keyboard, press the down arrow key to quickly select a group of
adjacent rows below the first row (press the up arrow key to de-select rows).

4. Click the Actions menu, select Selection, and select Copy Down.

Tip:

You can also use the Selection Actions menu in the header row to
quickly access several Selection submenu options (including Copy
Down).

The first row is copied to the rows selected below it.

Chapter 3
Using an Editable Interactive Grid

3-36



Tip:

Undo changes to the data by clicking Revert Changes in the Selection or Selection
Actions menus.

3.6.4.4 Copying to Multiple Cells in an Editable Interactive Grid
Copy the value of a cell and apply it to a group of cells in the same column by using Copy
Down in the Actions, Selection submenu.

To apply the value of an existing cell to a group of cells below it:

1. Ensure you are in Cell Selection mode.

2. Select the cell you want to copy.

3. Do one of the following to select the cells you want to change (all cells in a single
selection must be contiguous):

• Using the mouse, hold the Shift key and click the last cell in the group.

• Using the keyboard, hold the Shift key and press the down arrow key to select cells.

4. Click the Actions menu, select Selection, and select Copy Down.

Tip:

You can also use the Selection Actions menu in the header row to quickly
access several Selection submenu options (including Copy Down).

The first cell is copied to the cells selected below it.

You can also select cells in adjacent columns and use Copy Down to copy the value of the
different cells in each column to cells below it (values do not copy across columns).

Tip:

Undo changes to the data by clicking Revert Changes in the Selection or Selection
Actions menus.

3.6.4.5 Filling Cells in an Editable Interactive Grid
Apply a single value to a group of cells in an editable interactive grid by using Fill in the
Actions, Selection submenu.

You can also apply a single value to all the cells in a row (or a group of rows) by using Fill in
Row Selection mode.

To

1. Ensure you are in Cell Selection mode (select Actions menu and then Selection, or
press F8).

2. Select the first cell of the group.
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3. Press and hold the Shift key, and use the mouse or arrow keys to select a group
of cells.

Tip:

All selected cells must be adjacent for a single Fill action. Repeat this
procedure for non-adjacent cells.

4. Select the Actions menu, select Selection, and select Fill.

The Fill Selection dialog displays.

5. Enter a value. Click OK.

The entered value applies to the selected cells.

Tip:

Undo changes to the data by clicking Revert Changes in the Selection or
Selection Actions menus.

3.6.4.6 Clearing Cells in an Interactive Grid
Delete the contents of multiple cells by using Clear in the Actions, Selection submenu.

You can also clear all of the cells in a row (or a group of rows) by using Fill in Row
Selection mode.

To delete the contents of a group of adjacent cells:

1. Ensure you are in Cell Selection mode (select Actions menu and then Selection,
or press F8).

2. Select the first cell of the group.

3. Press and hold the Shift key, and use the mouse or arrow keys to select a group
of cells.

Tip:

All selected cells must be adjacent for a single Clear action. Repeat this
procedure for non-adjacent cells.

4. Select the Actions menu, select Selection, and select Clear.

The value of the selected cells is replaced with an empty text string.

You do not need to save the report because Clear directly affects the data in the
database.
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Tip:

Undo changes to the data by clicking Revert Changes in the Selection or Selection
Actions menus.

3.7 Saving Interactive Grids
Save your changes as a new report within the application. Name and keep these interactive
grid reports Private or make them Public to share with other users.

• About Interactive Grid Report Types
Reports in interactive grids have different uses and characteristics. You interact with the
Primary report of an interactive grid, and save your changes as Private reports.

• Saving a Report in an Interactive Grid
Save your changes to an interactive grid by clicking Save As in the Actions, Report
submenu.

• Renaming a Report in an Interactive Grid
Change the name of an interactive grid report by selecting Edit in the Actions, Report
submenu.

• Deleting a Report in an Interactive Grid
Delete a Private report from an interactive grid by selecting Delete in the Actions, Report
submenu.

3.7.1 About Interactive Grid Report Types
Reports in interactive grids have different uses and characteristics. You interact with the
Primary report of an interactive grid, and save your changes as Private reports.

The following is a list of default report types in Oracle Application Express, although
developers can choose to add more:

Private Report
You can save a Private report of the interactive grid to preserve your changes to it (such as
filters, aggregations, column order, visible columns, and other customizations).
Private reports can only be viewed by the user who creates them.

Primary Report
The default view of an interactive grid is the Primary report.
While you can customize the look and organization of a Primary report, you cannot overwrite
or rename it. The Primary report is useful as a backup or a starting point for customizing new
views of the interactive grid.

After you save at least one private report, a drop-down list appears on the toolbar near the
Search bar. You can use this to select between reports.

Chapter 3
Saving Interactive Grids

3-39



See Also:

"How the User Type Effects Available Save Options" in the Oracle
Application Express App Builder User’s Guide

3.7.2 Saving a Report in an Interactive Grid
Save your changes to an interactive grid by clicking Save As in the Actions, Report
submenu.

To save a Private interactive grid:

1. Click the Actions menu and select Report then Save As.

The Save As dialog displays.

2. In the Save As dialog:

a. Type - Select Private.

b. Name - Enter a name for the grid.

3. Click Save.

Save further changes to the report by selecting Save in the Actions, Report Setting
submenu.

The report is saved and a confirmation message displays.

If there is now more than one saved report available in the interactive grid, a drop-
down list appears on the toolbar between the Search Bar and Actions menu.
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3.7.3 Renaming a Report in an Interactive Grid
Change the name of an interactive grid report by selecting Edit in the Actions, Report
submenu.

To rename a report:

1. Select the report from the drop-down list.

2. Click the Actions menu and select Report then Edit.

The Report Settings dialog displays.

3. Rename the report.

4. Click Save.

The report is saved.

3.7.4 Deleting a Report in an Interactive Grid
Delete a Private report from an interactive grid by selecting Delete in the Actions, Report
submenu.

To delete an interactive grid report:

1. Select the report from the drop-down list.

2. Click the Actions menu and select Report then Delete.

A confirmation dialog appears.

3. Click OK.

The report is deleted and the Primary report reloads.

3.8 Resetting Interactive Grids
You can refresh, reset, or flashback a grid to revert your changes to it. Resetting an
interactive grid can have different outcomes depending on the report type.

Refresh an interactive grid to update it with the most recent version of the data in the
database. Reset an interactive grid to undo any changes since it was last saved. Flashback a
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grid to a point in the past (in minutes) to retrieve data from the database as it existed
at that time, which ignores any changes made to the data in the database since that
time.

• Refreshing an Interactive Grid
Update an interactive grid with the most current data available on the database by
selecting Refresh in the Actions, Data submenu.

• Resetting an Interactive Grid
Undo changes to an interactive grid by clicking the Reset button or by selecting
Reset from the Actions, Report submenu.

• How the Reset Button Affects Saved Interactive Grid Reports
Clicking the Reset button reloads an interactive grid’s last saved state. The saved
state varies between report types.

• Reverting an Interactive Grid to a Specific Save State
Revert an interactive grid to a specific point in time by selecting the Flashback in
the Actions, Data submenu.

3.8.1 Refreshing an Interactive Grid
Update an interactive grid with the most current data available on the database by
selecting Refresh in the Actions, Data submenu.

Refreshing an interactive grid is quicker than reloading the entire page in the browser.
Refreshing is also a valuable feature for highly fluid data sets.

To refresh an interactive grid:

1. Click the Actions menu and select Data.

2. Select Refresh.

The grid refreshes. Updates to the data are applied, but not marked.

3.8.2 Resetting an Interactive Grid
Undo changes to an interactive grid by clicking the Reset button or by selecting Reset
from the Actions, Report submenu.

WARNING:

Resetting an interactive grid reverts it to a previously saved state. Any
changes since that time may be lost.
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To reset an interactive grid, do one of the following:

• Click the Reset button.

• Click the Actions menu, select Report, and select Reset.

The grid reloads the last saved state.

3.8.3 How the Reset Button Affects Saved Interactive Grid Reports
Clicking the Reset button reloads an interactive grid’s last saved state. The saved state varies
between report types.

In a Primary report, the Reset button undoes all changes that you have made—including
reorganization and new content—because only developers can overwrite Primary reports. To
preserve your changes, save a Private report.

In a Private report, the Reset button undoes only the changes that you have made since the
last time you saved the report.

See Also:

Saving Interactive Grids
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3.8.4 Reverting an Interactive Grid to a Specific Save State
Revert an interactive grid to a specific point in time by selecting the Flashback in the
Actions, Data submenu.

To revert an interactive grid:

1. Click the Actions menu, select Data, and select Flashback.

The Flashback dialog displays.

2. Enter the number of minutes into the past that you wish to return to.

3. Click Save.

The grid reloads.

3.9 Downloading or Emailing an Interactive Grid
Download or email an interactive grid as a CSV, HTML, Excel, or PDF file by selecting
Download in the Actions menu.

To download or email an interactive grid:

1. Click the Actions menu and select Download.

The Download dialog displays.

2. Choose report download format - Select CSV, HTML, Excel, or PDF.

Extra PDF options may appear if you use native PDF printing without an external
print server.

3. For PDF, choose the Page Size, Page Orientation, and whether to include
Accessibility Tags.

Enabling Include Accessibility Tags enables the document to be read aloud by a
screen reader and other text-to-speech tools (this increases the file size of the
PDF).

4. Data Only - Enable Data Only to include only columns and rows and ignores any
active column groups, aggregates, highlights and control breaks.

5. (Optional) Strip Rich Text - Enable Strip Rich Text to remove Rich Text
formatting from the file output. (Option only appears for interactive grids containing
a Rich Text column.)
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6. Do one of the following:

• To download the file, click Download.

• To email the file as an attachment to an email:

a. Enable Send as Email.

b. Complete the fields for the recipients (To, Cc, Bcc, Subject, Body).

c. Click Send.

See Also:

Configuring Interactive Grid Download Formats in Oracle Application Express App
Builder User’s Guide
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4
Using Interactive Reports

An interactive report is a formatted result of a SQL query.

• About Interactive Reports
In addition to interactive grids, Oracle Application Express includes two main report
types: an interactive report and a classic report.

• Using the Search Bar
A search bar displays above interactive reports and includes the following features.

• Using the Select Columns To Search Icon
The Select columns to search icon displays to the left of the search bar. Click this icon to
display a listing of all columns in the current report.

• Using the Column Heading Menu
Clicking a column heading in an interactive report displays the Column Heading menu.
Positioning the cursor over each icon displays a tooltip that describes its function.

• Using Interactive Report Filters
When you customize an interactive report, a filter displays between the search bar and
the report.

• Customizing an Interactive Report Using the Actions Menu
Customize an interactive report by selecting options on the Actions menu.

See Also:

"Managing Interactive Reports" in Oracle Application Express App Builder User’s
Guide

4.1 About Interactive Reports
In addition to interactive grids, Oracle Application Express includes two main report types: an
interactive report and a classic report.

The main difference between these two report types is that interactive reports enable you to
customize the appearance of the data through searching, filtering, sorting, column selection,
highlighting, and other data manipulations.

About Interactive Reports

The following is an example of an interactive report in the packaged application, Sample
Reporting.
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Interactive reports enable you to create highly customized reports. You can alter the
report layout by hiding or exposing specific columns and applying filters, highlighting,
and sorting. You can also define breaks, aggregations, charts, group data, and add
their own computations. Once customized, the report can be saved as either a private
or public report. Most interactive reports include a search bar, Actions menu, Column
Heading menu, and edit icons in the first column of each row.

In contrast, classic reports support general keyword search capability, the ability to
specify the number of rows that display, and basic column sorting.

See Also:

"Utilizing Packaged Applications" in Oracle Application Express App Builder
User’s Guide

4.2 Using the Search Bar
A search bar displays above interactive reports and includes the following features.

• Select columns to search icon - Resembles a magnifying glass. Click this icon to
narrow your search to specific columns. To search all columns, select All
Columns. See "Using the Select Columns To Search Icon."

• Text area - Enter case insensitive search criteria (wildcard characters are implied)
and then click Go.

• Go button - Executes a search.
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• View Report - Displays alternate default and saved private or public reports. See "Saving
an Interactive Report."

• View icons - Switches between an icon, report and detail view of the default report (if
enabled). May also include Chart and Group By View (if defined). Icons do not display by
default, but must be configured by the developer.

• Actions menu - Use the Actions menu to customize an interactive report. See
"Customizing an Interactive Report Using the Actions Menu."

Tip:

Developers can customize what displays on the Search bar. To learn more, see
"Customizing the Interactive Search Bar" in Oracle Application Express App Builder
User’s Guide.

4.3 Using the Select Columns To Search Icon
The Select columns to search icon displays to the left of the search bar. Click this icon to
display a listing of all columns in the current report.

To search specific columns:

1. Click the Select columns to search icon and select a column.

2. Enter keywords in the Text area and click Go.

3. To disable the filter, select the Enable/Disable Filter check box.

4. To delete the filter, click the Remove Filter icon.

See Also:

"Selecting Columns to Display"
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4.4 Using the Column Heading Menu
Clicking a column heading in an interactive report displays the Column Heading menu.
Positioning the cursor over each icon displays a tooltip that describes its function.

Column Heading menu options include:

• Sort Ascending - Sorts the report by the column in ascending order.

• Sort Descending - Sorts the report by the column in descending order.

• Hide Column - Hides the column. Not all columns can be hidden. If a column
cannot be hidden, the Hide Column icon does not display. To show a hidden
column, select Reset from the Actions menu.

• Control Break - Creates a break group on the column. This pulls the column out of
the report as a master record. See "Creating a Control Break."

• Column Information - Displays help text about the column, if available.

• Filter - Enter a case insensitive search criteria. Entering a value reduces the list of
values at the bottom of the menu. You can then select a value from the bottom.
The selected value will be created as a filter using either the equal sign (=) or
contains depending on the List of Values Column Filter Type.

4.5 Using Interactive Report Filters
When you customize an interactive report, a filter displays between the search bar and
the report.

The following illustration shows a report with two filters Project = 'Bug Tracker' and
Status = 'On-Hold'. By default, filters display in the Report Settings area above the
report. You can show or hide the filter details by clicking the arrow to the left of the filter
name.
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When you expand a filter and view the details, you can edit it as follows:

• Enable/Disable - To enable and disable a filter, select and deselect the check box to the
left of the filter name.

• Filter Edit - To edit a filter, click the filter name.

• Remove Filter - To remove a filter, select the Remove Filter icon to the right of the filter
name.

4.6 Customizing an Interactive Report Using the Actions Menu
Customize an interactive report by selecting options on the Actions menu.

Tip:

Not all options described in this section are available on every Actions menu.
Developers can customize what options appear. To learn more, see "Customizing
the Interactive Report Search Bar" in Oracle Application Express App Builder User’s
Guide.
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• About the Actions Menu
The Actions menu appears to the right of the Go button on the Search bar. Use
this menu to customize an interactive report.

• Selecting Columns to Display
Customize a report to include specific columns.

• Adding a Filter
Create row and column filters on an interactive report.

• Selecting Column Sort Order
You can specify column display sort order (ascending or descending) by selecting
Sort on the Data submenu.

• Creating a Control Break
You can create a break group of one or several columns by selecting Actions,
Format, and Control Break.

• Adding Highlighting
Customize the display to highlight specific rows in a report by selecting Highlight
on the Actions, Format submenu.

• Computing Columns
Add mathematical computations (for example, NBR_HOURS/24) or standard Oracle
functions to columns.

• Defining an Aggregation Against a Column
Define an aggregation against a column with the Actions, Data submenu.
Aggregates are displayed after each control break and at the end of the report
within the column for which they are defined.

• Creating a Chart from the Actions Menu
Create charts in an interactive report with the Actions menu. You can create one
chart for each interactive report. Once defined, you can switch between the chart
and report views using buttons on the Search bar.

• Grouping Columns
Group sets of results by one or more columns with Group By, then perform
mathematical computations against the columns. Once you define the Group By,
switch between the group by and report views using the View Icon on the Search
bar.

• Managing Pivot Reports
Pivot reports transpose rows into columns to generate results in a crosstab format.

• Executing a Flashback Query
View the data as it existed at a previous point in time by executing a flashback
query on the Actions, Data submenu.

• Saving an Interactive Report
Save a private or public interactive report. Only the user who creates a private
report can view, save, rename, or delete that private report.

• Resetting a Report
Reset a report back to the default settings by selecting Reset from the Actions,
Report submenu. Resetting a report removes any customizations you have made.

• Downloading a Report
Download or email an interactive report as a CSV, HTML, Excel, or PDF file by
selecting Download in the Actions menu.

Chapter 4
Customizing an Interactive Report Using the Actions Menu

4-6



• Subscribing to Report Updates by Email
Subscribe to an interactive report to receive updated versions it.

4.6.1 About the Actions Menu
The Actions menu appears to the right of the Go button on the Search bar. Use this menu to
customize an interactive report.

Actions Menu

The Actions menu contains the following options:

Columns
Specifies which columns to display and in what order. See "Selecting Columns to Display."

Filter
Focuses the report by adding or modifying the filter clause on the query. See "Adding a
Filter."

Data
Contains the Data submenu (see below).

Format
Contains the Format submenu (see below).
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Chart
Displays the report data as a chart. See "Creating a Chart from the Actions Menu."

Group By
Enables users to group the result set by one or more columns and perform
mathematical computations against columns. See "Grouping Columns."

Pivot
Enables users to define a Pivot report. See "Managing Pivot Reports."

Report
Contains the Report submenu.
Manage your private and public reports of the interactive grid.
Saves the interactive report. Depending upon their user credentials, users can save
different types of reports. See "Saving an Interactive Report."
Revert the grid to its last saved state with the Reset function.

Reset
Resets the report back to the default report settings. See "Resetting a Report."

Download
Downloads a report. Available download formats depend upon your installation and
report definition. See "Downloading a Report."

Subscription
Send an interactive report by email. See "Subscribing to Report Updates by Email."

Help
Provides descriptions of how to customize interactive reports.

Data Submenu

The Actions Menu also contains the Data submenu. The Data submenu contains the
following options:

Sort
Changes the columns to sort on and determines whether to sort in ascending or
descending order. See "Selecting Column Sort Order."

Aggregate
Enables users to perform mathematical computations against a column. See "Defining
an Aggregation Against a Column."

Compute
Enables users to add computed columns to a report. See "Computing Columns."

Flashback
Enables users to view the data as it existed at a previous point in time. See
"Executing a Flashback Query."

Format Submenu

The Actions Menu also contains the Format submenu. The Format submenu contains
the following options:
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Control Break
Creates a break group on one or several columns. This pulls the columns out of the
interactive report and displays them as a master record. See "Creating a Control Break."

Highlight
Defines a filter that highlights the rows that meet the filter criteria. See "Adding Highlighting."

Rows Per Page
Select the number of rows that display per page.

4.6.2 Selecting Columns to Display
Customize a report to include specific columns.

To use the Select Columns option:

1. Click the Actions menu and select Columns.

The Select Columns dialog appears.

2. Select the columns you want to move. Click the center arrows to move a column from
Display in Report to Do Not Display. To select multiple columns at once, press and hold
the CTRL key.

3. To change the order of the columns, click the Top, Up, Down, and Bottom arrows on the
right.

4. Click Apply.

A revised report appears.

See Also:

"Resetting a Report"

4.6.3 Adding a Filter
Create row and column filters on an interactive report.

• About Creating Filters
You can create a filter on an interactive report by adding or modifying the WHERE clause on
the query.

• Adding, Editing, and Removing a Column Filter
Use the Actions menu to add, edit, or remove a column filter in an interactive report.

• Adding, Editing, and Removing a Row Filter
Use the Actions menu to add, edit, or remove a row filter in an interactive report.

4.6.3.1 About Creating Filters
You can create a filter on an interactive report by adding or modifying the WHERE clause on the
query.

You can create two types of filters:
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• Column - Creates a custom column filter. Select a column, select a standard
Oracle operator (=, !=, not in, between), and enter an expression to compare
against. Expressions are case sensitive. Use the percent sign (%) as a wildcard.
Note that the selected column does not need to be one that currently displays. For
example:

STATE_NAME like A%
• Row - Creates a custom row filter. This filter creates a complex WHERE clauses

using column aliases and any Oracle functions or operators. For example:

 G = 'VA' or G = 'CT'

Where G is the alias for CUSTOMER_STATE.

4.6.3.2 Adding, Editing, and Removing a Column Filter
Use the Actions menu to add, edit, or remove a column filter in an interactive report.

To add a column filter:

1. Click the Actions menu and select Filter.

The Filter dialog appears.

2. For Filter Type, select Column.

3. In the Filter region, specify a column, an operator, and an expression and click
Apply.

Notice the filter that displays in the Report Settings area above the report. You can
show or hide the filter details by clicking the arrow to the left of the filter name.

To revise the filter:

4. Click the filter name (in this example, Project = 'Discussion Forum').

5. Edit your selections and click Apply.

6. To disable the filter, select the Enable/Disable Filter check box.

7. To delete the filter, click Remove Filter.
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4.6.3.3 Adding, Editing, and Removing a Row Filter
Use the Actions menu to add, edit, or remove a row filter in an interactive report.

To add a row filter:

1. Click the Actions menu and select Filter.

The Filter dialog appears.

2. For Filter Type, select Row.

3. In the Filter dialog:

a. Name - Enter a name that describes this filter.

b. Filter Expression - Enter an expression. Select a column and function or operator at
the bottom of the region. For example, I >=2500 displays projects costing more
than $2,500.

c. Click Apply.

Notice the filter that displays in the Report Settings area above the report. You can
show or hide the filter details by clicking the arrow to the left of the filter name.

4. To revise the filter:

a. Click the filter name.

b. Edit your selections and click Apply.

5. To disable the filter, select the Enable/Disable Filter check box.

6. To delete the filter, click Remove Filter.

4.6.4 Selecting Column Sort Order
You can specify column display sort order (ascending or descending) by selecting Sort on the
Data submenu.

You can also specify how to handle NULL values. Using the default setting always displays
NULL values last or always displays them first.

To sort by column:

1. Click the Actions menu and select Data and then Sort.

The Sort dialog appears.

2. Select a column, the sort direction (Ascending or Descending), and Null Sorting
behavior (Default, Nulls Always Last, or Nulls Always First).

3. Click Apply.

4.6.5 Creating a Control Break
You can create a break group of one or several columns by selecting Actions, Format, and
Control Break.

Creating a break group pulls the columns out of the interactive report and displays them as a
master record.

To create a break group:
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1. Click the Actions menu and select Format and then Control Break.

The Control Break dialog appears.

2. Select a column and then a status (Enable or Disable).

3. Click Apply.

A revised report displays.

Note the defined filter displays in the Report Settings area above the report.

4. Click the left arrow to expand the filter.

5. To disable the Control Break filter, deselect the Enable/Disable Filter check box.
To activate a disabled filter, select the Enable/Disable Filter check box again.

6. To delete the filter, click Remove Control Break.

4.6.6 Adding Highlighting
Customize the display to highlight specific rows in a report by selecting Highlight on
the Actions, Format submenu.

To add highlighting:

1. Click the Actions menu and select Format and then Highlight.

The Highlight dialog appears.

2. Edit the following information:

a. Name - Enter a name that describes this filter.

b. Sequence - Enter a numeric value to identify the sequence in which
highlighting rules are evaluated.

c. Enabled - Select Yes.

d. Highlight Type - Select Cell or Row.
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e. Background Color - Select a new color for the background of the highlighted area.

f. Text Color - Select a new color for the text in the highlighted area.

g. Highlight Condition - Select a column, an operator, and expression.

h. Click Apply.
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Tip:

Note the highlight On-Hold Projects displays in the Report Settings
area above the report. You can show or hide the filter details by clicking
the arrow to the left of the filter name.

3. To revise the highlight, click the highlight name and make the following edits:

a. Background Color - Select yellow.

b. Text Color - Select red.

c. Click Apply.

4. To disable the highlight, select the Enable/Disable check box.

5. To delete the highlight, click Remove Highlight.

4.6.7 Computing Columns
Add mathematical computations (for example, NBR_HOURS/24) or standard Oracle
functions to columns.

• Creating a Computation
Use the Compute function in the Actions, Data submenu to add a computation to a
column.

• Deleting a Computation
Open the Compute dialog to remove a computation.

4.6.7.1 Creating a Computation
Use the Compute function in the Actions, Data submenu to add a computation to a
column.

To create a computation:

1. Click the Actions menu and select Data and then Compute.

The Compute dialog appears.

2. In the Compute dialog:

a. Computation - Select New Computation.

b. Column Label - Enter the name of the new column to be created.

c. Format Mask - Select an Oracle format mask to be applied to the new column.
(For example, $5,234.10).

3. Create the computation:

a. Columns - Select a column or alias.

b. Keypad - Select a shortcut for commonly used keys.

c. Functions - Select the appropriate function.

In the following example, a new column compares the actual cost to the budgeted
amount, using the formula I - H, where I is the budgeted amount and H is the
cost.

4. Click Apply.
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The revised report appears containing a new Cost Analysis column.

4.6.7.2 Deleting a Computation
Open the Compute dialog to remove a computation.

To delete a computation:

1. Click the Actions menu and select Data and then Compute.

The Compute dialog appears.

2. From Computation, select the computation.

The computation appears.

3. Click Delete.

4.6.8 Defining an Aggregation Against a Column
Define an aggregation against a column with the Actions, Data submenu. Aggregates are
displayed after each control break and at the end of the report within the column for which
they are defined.

• Creating an Aggregation Against a Column
Create an aggregation by selecting Aggregate in the Actions, Data submenu.

• Removing a Column Aggregation
Open the Aggregate dialog to remove an aggregation.

4.6.8.1 Creating an Aggregation Against a Column
Create an aggregation by selecting Aggregate in the Actions, Data submenu.

To create an aggregation against a column:

1. Click the Actions menu and select Data and then Aggregate.

The Aggregate dialog appears.

2. In the Aggregate dialog:
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a. Aggregation - Select New Aggregation.

b. Function - Select one of the following: Sum; Average, Count, Count Distinct,
Minimum, Maximum, or Median.

c. Column - Select a column.

This example creates a sum of the Cost column.

d. Click Apply.

The computation appears at the bottom of the last page of the report. In this
example, the aggregate shows the sum of all amounts in the Cost column.

4.6.8.2 Removing a Column Aggregation
Open the Aggregate dialog to remove an aggregation.

To remove column aggregation:

1. Click the Actions menu and select Data and then Aggregate.

The Aggregate dialog appears.

2. From Aggregation, select a previously defined aggregation.

3. Click Delete.
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4.6.9 Creating a Chart from the Actions Menu
Create charts in an interactive report with the Actions menu. You can create one chart for
each interactive report. Once defined, you can switch between the chart and report views
using buttons on the Search bar.

• Creating a Chart
Use the Chart function in the Actions menu to create a chart in an interactive report.

• Editing a Chart
Open the Chart dialog to edit a chart in an interactive report.

• Deleting a Chart
Open the Chart dialog to remove a chart in an interactive report.

4.6.9.1 Creating a Chart
Use the Chart function in the Actions menu to create a chart in an interactive report.

To create a chart:

1. Click the Actions menu and select Chart.

The Chart dialog appears.

2. In the Chart dialog, specify the appropriate options.

a. Chart Type - Select the type of chart you want to create (horizontal bar, vertical bar,
pie, or line).

b. Label - Select the column to be used as the label.

c. Axis for Title for Label - Enter the title to display on the axis associated with the
column selected for Label (not available for pie chart)

d. Value - Select the column to be used as the Value. If your function is a COUNT, a Value
does not need to be selected.

e. Axis Title for Value - Enter the title to display on the axis associated with the column
selected for Value (not available for pie chart).

f. Function - (Optional) Select a function to be performed on the column selected for
Value.

g. Orientation - Select whether chart elements extend up and down or sideways. (Not
applicable for pie charts.)

h. Sort - Select a sorting method.

3. Click Apply.

The chart appears.

Tip:

The Search bar now contains two icons: View Report and View Chart. Click these
icons to toggle between chart and report views.
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4.6.9.2 Editing a Chart
Open the Chart dialog to edit a chart in an interactive report.

To edit a chart:

1. While viewing a report:

a. Click the Actions menu and select Chart.

The Chart dialog appears.

b. Edit your selections and click Apply.

2. While viewing a chart:

a. Click Edit Chart.

b. Edit your selections and click Apply.

4.6.9.3 Deleting a Chart
Open the Chart dialog to remove a chart in an interactive report.

To delete a chart:

1. While viewing a report:

a. Click the Actions menu and select Chart.

The Chart dialog appears.

b. Click Delete.

2. While viewing a chart:

a. Click Edit Chart.

b. Click Delete.

Tip:

You can also click the Remove Chart icon to the right of the Edit Chart
filter.

4.6.10 Grouping Columns
Group sets of results by one or more columns with Group By, then perform
mathematical computations against the columns. Once you define the Group By,
switch between the group by and report views using the View Icon on the Search bar.

• Creating a Group By
Use the Group By function in the Actions menu to reorganize an interactive grid.

• Editing a Group By
Edit the properties of a grouping in the Goup By dialog.

• Selecting a Group By Sort Order
Specify group by column sort order (ascending or descending) by either clicking
on the group by column heading or selecting Group By Sort on the Data submenu.
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• Deleting a Group By
Delete a grouping in the Group By dialog.

4.6.10.1 Creating a Group By
Use the Group By function in the Actions menu to reorganize an interactive grid.

To use Group By:

1. Click the Actions menu and select Group By.

The Group By dialog appears.

2. In the Group by dialog:

a. Select a column to display. To add additional columns, click Add Group By Column.

b. Select the function, column, label, and format mask. To create a sum, click the Sum
check box. To add another function, click Add Function.

c. Click Apply.
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A Group By icon appears to the left of the Actions menu. The resulting report displays
the Project, Task Name, and Budget columns. Additionally, a new column, Total Cost,
displays on the right side.

4.6.10.2 Editing a Group By
Edit the properties of a grouping in the Goup By dialog.

To edit a group by:

1. Click Edit Group By.

The Group By dialog appears.

2. Edit the attributes.

3. To remove a previously defined Group by Column, select the default setting Select
Group By Column.

4. Click Apply.

4.6.10.3 Selecting a Group By Sort Order
Specify group by column sort order (ascending or descending) by either clicking on the
group by column heading or selecting Group By Sort on the Data submenu.

You can also specify how to handle NULL values. Using the default setting always
displays NULL values last or always displays them first.

To sort a group by column:

1. Access a Group By view.

2. Click the Actions menu, select Data, and select Group By Sort.

Tip:

The Group By Sort menu is only visible when you are viewing Group By
view.

The Group By Sort dialog appears.

3. Select a column, the sort direction (Ascending or Descending), and Null Sorting
behavior (Default, Nulls Always Last, or Nulls Always First).

4. Click Apply.

See Also:

Creating a Group By

4.6.10.4 Deleting a Group By
Delete a grouping in the Group By dialog.
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To delete a group by:

1. Click Edit Group By.

The Group By dialog appears.

2. Click Delete.

Tip:

You can also click the Remove Group By icon to the right of the Edit Group By filter.

4.6.11 Managing Pivot Reports
Pivot reports transpose rows into columns to generate results in a crosstab format.

Select pivot columns and rows and then provide the functions to be represented in the pivot
report. Once created, pivot reports display a new icon in the search bar.

• Creating a Pivot Report
Create a pivot report by opening the Pivot dialog from the Actions menu.

• Editing a Pivot Report
Edit a pivot report by clicking the Edit Pivot filter in an interactive report and opening the
Pivot dialog.

• Deleting a Pivot Report
Remove a pivot report from an interactive report in the Pivot dialog.

4.6.11.1 Creating a Pivot Report
Create a pivot report by opening the Pivot dialog from the Actions menu.

To create a pivot report:

1. Click the Actions menu and select Pivot.

The Pivot dialog appears.

2. In the Pivot dialog:

a. Pivot Columns - Select the columns to display (for example, Status). To add
additional columns, click Add Pivot Column.

b. Row Columns - Select the rows to display (for example, Project). To add additional
columns, click Add Row Column.

c. Computation:

• Select a function, column, label, and format mask.

• To create a sum, click the Sum check box (optional).

d. Click Apply.

The Search Bar now contains two icons: View Report and View Pivot. Click these icons to
toggle between the report view and the pivot view.

The following example shows a Pivot report that displays the number of closed, on-hold,
open, and pending tasks associated with each project.
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4.6.11.2 Editing a Pivot Report
Edit a pivot report by clicking the Edit Pivot filter in an interactive report and opening
the Pivot dialog.

To edit a pivot report:

1. Click the Edit Pivot filter.

The Pivot dialog appears.

2. Edit the attributes.

3. To remove a previously defined column or row, select the default setting, Select
Pivot Column and Select Row Column.

4. Click Apply.

4.6.11.3 Deleting a Pivot Report
Remove a pivot report from an interactive report in the Pivot dialog.

To delete a pivot report:

1. Click the Edit Pivot filter.

The Pivot dialog appears.

2. Click Delete.

Tip:

You can also click the Remove Pivot icon to the right of the Edit Pivot filter.
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4.6.12 Executing a Flashback Query
View the data as it existed at a previous point in time by executing a flashback query on the
Actions, Data submenu.

The default amount of time that you can flashback is 3 hours (or 180 minutes) but the actual
amount is different for each database.

• Creating a Flashback Query
Create a flashback query by using the Actions, Data submenu.

• Editing a Flashback Query
Edit a flashback query by clicking the flashback query filter in an interactive report.

• Deleting a Flashback Query
Delete a flashback query by using the flashback query filter dialog in an interactive report.

4.6.12.1 Creating a Flashback Query
Create a flashback query by using the Actions, Data submenu.

To execute a flashback query:

1. Click the Actions menu and select Data then Flashback.

2. In the Flashback field, enter the number of minutes.

3. Click Apply.

4.6.12.2 Editing a Flashback Query
Edit a flashback query by clicking the flashback query filter in an interactive report.

To edit a flashback query:

1. Click flashback query filter.

The Flashback dialog appears.

2. Edit minute ago attribute.

3. Click Apply.

4.6.12.3 Deleting a Flashback Query
Delete a flashback query by using the flashback query filter dialog in an interactive report.

To delete a flashback query:

1. Click the flashback query filter.

The Flashback dialog appears.

2. Click Delete.

Chapter 4
Customizing an Interactive Report Using the Actions Menu

4-23



Tip:

You can also click the Remove Flashback icon to the right of the flashback
query filter.

4.6.13 Saving an Interactive Report
Save a private or public interactive report. Only the user who creates a private report
can view, save, rename, or delete that private report.

• About the Report List
You can view different versions of an interactive report by selecting from a drop-
down list of default or primary reports and private reports.

• About Configuration Dependencies
The ability to save an interactive report is configurable by the application
developer who creates the interactive report.

• Saving a Public or Private Interactive Report
End users can save an interactive report and classify it as Public or Private.

• Renaming a Public or Private Interactive Report
Rename a public or private report that you have created by clicking its report
name.

• Deleting a Public or Private Interactive Report
Remove a public or private report that you have created by clicking its Remove
Report icon.

4.6.13.1 About the Report List
You can view different versions of an interactive report by selecting from a drop-down
list of default or primary reports and private reports.

The following illustration shows the Reports list on the Search bar of an interactive
report.

This example shows two reports:
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Default - Primary Report
This is the initial report created by the application developer. Default, Primary reports cannot
be renamed or deleted.

Private - 1. Open Projects
This is a Private report. Only the user who creates a private report can view, save, rename,
or delete it.

4.6.13.2 About Configuration Dependencies
The ability to save an interactive report is configurable by the application developer who
creates the interactive report.

See Also:

• "Customizing the Interactive Report Search Bar" in Oracle Application Express
App Builder User’s Guide

• "Saving Interactive Repor" in Oracle Application Express App Builder User’s
Guide

4.6.13.3 Saving a Public or Private Interactive Report
End users can save an interactive report and classify it as Public or Private.

Public
The report can be saved, renamed, or deleted by the end user who created it. Other users
can view and save the layout as another report.

Private
Only the end user that created the report can view, save, rename or delete the report.

To save a public or private interactive report:

1. Go to the page containing the interactive report you want to save.

2. Customize the report (for example, hide columns, add filters, and so on).

3. Click the Actions menu and select Report then Save Report.

The Save Report dialog appears.
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4. In Save Report:

a. Select either As Named Report or As Default Report Settings option.

Tip:

This option is available for only developers.

b. Name - Enter a name for the report.

c. Description - Enter an optional description.

d. Public - Select this check box to make the report viewable to all users.
Deselect this check box to make the report private.

Tip:

The ability to save an interactive report as Public is determined by
your application developer.

e. Click Apply.

See Also:

• Customizing an Interactive Report Using the Actions Menu

• About Configuration Dependencies

4.6.13.4 Renaming a Public or Private Interactive Report
Rename a public or private report that you have created by clicking its report name.

To rename a public or private interactive report:

1. Select a public or private interactive report to rename.

2. Click the Saved Report filter which displays between between the search bar and
the report.

3. In the Rename Report dialog, edit the attributes (for example, enter a new name).

4. Click Apply.

4.6.13.5 Deleting a Public or Private Interactive Report
Remove a public or private report that you have created by clicking its Remove Report
icon.

To delete a public or private interactive report:

1. Click the Remove Report icon next to the report name link.
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2. Click Apply.

4.6.14 Resetting a Report
Reset a report back to the default settings by selecting Reset from the Actions, Report
submenu. Resetting a report removes any customizations you have made.

To reset a report:

1. Click the Actions menu and select Report then Reset.

2. Click Apply.

4.6.15 Downloading a Report
Download or email an interactive report as a CSV, HTML, Excel, or PDF file by selecting
Download in the Actions menu.

To download or email an interactive report:

1. Click the Actions menu and select Download.

The Download dialog displays.

2. Choose report download format - Select CSV, HTML, Excel, or PDF.

Extra PDF options may appear if you use native PDF printing without an external print
server.

3. For PDF, choose the Page Size, Page Orientation, and whether to include Accessibility
Tags.

Enabling Include Accessibility Tags enables the document to be read aloud by a
screen reader and other text-to-speech tools (this increases the file size of the PDF).

4. Data Only - Select Data Only to include only columns and rows and ignores any active
column groups, aggregates, highlights and control breaks.

5. (Optional) Strip Rich Text - Enable Strip Rich Text to remove Rich Text formatting from
the file output. (Option only appears for interactive grids containing a Rich Text column.)

6. Do one of the following:

• To download the file, click Download.

• To email the file as an attachment to an email:

a. Enable Send as Email.
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b. Complete the fields for the recipients (To, Cc, Bcc, Subject, Body).

c. Click Send.

See Also:

Configuring Interactive Report Actions Menu Download Options in Oracle
Application Express App Builder User’s Guide

4.6.16 Subscribing to Report Updates by Email
Subscribe to an interactive report to receive updated versions it.

• How Report Subscriptions Work
You can subscribe to a report by clicking Subscription on the Actions menu.

• Subscribing to Updated Report Results
Subscribe to a report by selecting Subscription in the Actions menu.

See Also:

"Managing Interactive Report Subscriptions" in Oracle Application Express
Administration Guide

4.6.16.1 How Report Subscriptions Work
You can subscribe to a report by clicking Subscription on the Actions menu.

Emails sent from an interactive report contain a system generated email signature that
cannot be overwritten that identifies who originated the email.

To use Subscription:

• An Application Express administrator must configure email at the Instance level.

• The application developer must select the report Attributes and enable the Actions
Menu, Subscription attribute.

• The application developer must enable Download.

See Also:

• Customizing the Interactive Report Actions Menu in Oracle Application
Express App Builder User’s Guide

• Configuring Interactive Report Actions Menu Download Options in
Oracle Application Express App Builder User’s Guide
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4.6.16.2 Subscribing to Updated Report Results
Subscribe to a report by selecting Subscription in the Actions menu.

Note:

Emails sent from a subscription include a system generated email signature
indicating who created the subscription. This signature cannot be removed.

To receive updated report results by email:

1. Click the Actions menu and select Subscription.

The Subscription dialog appears.

2. Under Subscription:

a. Email Address - Enter the email addresses to receive the report. To include multiple
email addresses, separate each email address with a comma.

b. Subject - Enter text to display in the email subject line.

c. Frequency - Select the interval at which the report is sent.

d. Starting From - Select a start date and time.

e. Ending - Select an end date and time. Select a day, week, month, or year.

f. Click Apply.
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